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General Information

Legal Notice
Information furnished is believed to be accurate and reliable. However, CORRSYS-DATRON
assumes no responsibility for the consequences of use of such information nor for any infringement
of patents or other rights of third parties which may result from its use. No license is granted by
implication or otherwise under any patent or patent rights of CORRSYS-DATRON. Specifications
mentioned in this publication are subject to change without notice and do not represent a commit-
ment on the part of CORRSYS-DATRON. This publication supersedes and replaces all information
previously supplied.

All brand names are trademarks of their respective holders.

Copyright Notice
© Copyright 2003, CORRSYS-DATRON

Revision
Created by:
CORRSYS-DATRON Sensorsystems, Inc.
Theodore Hoag/Patrick Christopher
Version 3.0 PRELIMINARY
November 16, 2002 / March 24, 2003
D834-50-01-03E / D836-50-01-03E

Contact
International Headquarters:
CORRSYS-DATRON Sensorsysteme GmbH
Charlotte-Bamberg-Str. 12
35523 Wetzlar / Germany
Phone ++49 (6441) 9282-0
Fax ++49 (6441) 9282-17
E-mail sales@corrsys-datron.com
URL www.corrsys-datron.com

North American Headquarters:
CORRSYS-DATRON Sensorsystems, Inc.
21654 Melrose Avenue, Building 16
Southfield, MI 48075 / USA
Phone ++1 (248) 204-0850
Toll-free++1 (800) 832-0732
Fax ++1 (248) 204-0864
E-mail sales@datron.com or USA-sales@corrsys-datron.com
URL www.corrsys-datron.com
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Safety Instructions
Please read carefully before operating the equipment.

CORRSYS-DATRON is not responsible for damage that may occur when this system is used in
any way other than that for which it is intended.

To assure safe and proper operation, all supplied equipment, components and/or accessories must be
carefully transported and stored, as well as professionally installed and operated. Careful maintenance
and usage in full accordance with operating instructions is imperative.

CORRSYS-DATRON equipment should be installed and operated only by qualified persons who are
familiar with devices of this type.

Local regulations may not permit the operation of motor vehicles on public highways while the
equipment is mounted on the exterior of the vehicle.

• Use the equipment only for intended applications. Improper application is not advised.

• Do not modify or change the equipment or its accessories in any way.

• Improper use or mounting of the equipment may affect the safety of the vehicle and/or occupants.

• The equipment must not be mounted and/or operated in any way that may compromise vehicle or 
and/or occupant safety.

• Equipment must be mounted firmly and securely.

• Use only original equipment, components and/or accessories included in the scope of delivery.

• Do not mount equipment, components and/or accessories near heat sources (e.g. exhaust).

• Do not use defective or damaged equipment, components and/or accessories .

• Always note correct pin assignments and operating voltages when connecting equipment to
power supplies, data acquisition/evaluation systems, and/or any other applicable system or
component. Equipment may be damaged if not properly connected and/or operated.

• For additional information, please contact the CORRSYS-DATRON service department.
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Volume 1: µEEP-5 / µEEP-10

1) µEEP-5 / µEEP-10 System Specifications

PC for mobile usage:

• 1 x Portax –7 case
• 1 x Cutout on the upper side of the Portax chassis
• 1 x 7-slot back plane (7xISA)
• 1 x USVI – Power supply 160watt.

Inputs 90-260 VAC 45-400Hz
10-32 VDC

• 1 x I-BUS Eagleray VES Slot-CPU motherboard.
Compatible with CPUs up to Celeron 500MHz or P III 800MHz
On Board Adaptec 7880 UW-SCSI Controller
On Board C&T 69000 VGA Controller, Max Res. 1280x1024
On Board Intel 82559 10/1000 Ethernet-Controller
NSL LM79 System Monitor

• 1 x 9.1GB IBM UW-SCSI mounted in Kingston Removable frame faceplate
• 1 x Intel Pentium III 700MHz CPU OEM delivery
• 1 x 256 SDRAM, 100MHz
• 1 x ISA-Bus Card X4 PC104 connectors for developing
• 1 x IDE CD- RW - X24-Write/X10-ReWrite/X40-Read
• 1 x Windows 2000 Professional CD-ROM OEM English Version with Service pack 2
• 1 x external back cover Parallel DB-15 Female LPT1 Port Interface connector
• 1 x external back cover Display DB26HD female display connector with just Power and GND.

Integrated Data Acquisition Components:
The following are available components. Not all systems are equipped with each component.

• Voltage to Digital PC104 DM408 Analog Card/s by Real Time Devices
• Digital Frequency Counter to Digital PC104 Card
• J1850 OBD card
• Softing CAN card
• Vector CAN card
• AD1-Module Faceplate with 16 x Analog 6 Pin Lemosa Female Differential Inputs
• AD2-Module Faceplate with 2 x DB15HD Female Single Ended Inputs (8 inputs per DB15HD)
• AD2s-Module Faceplate with 2 x DB15HD Female Single Ended Inputs with Digital Control for 

Multiplexor Module and Switches (8 inputs per DB15HD)
• Count-Module Faceplate 4 x DB9 Male RS 484 compatible (2 Inputs per DB9)
• CAN-Module Faceplate 2 x DB9 Male (one can bus per DB9) note: termination at both ends 124 Ohms
• SAE-Module 1 x DB15 Male Vehicle Bus Connector J1850 Data Port
• Switch 1 x DB9 Male (4 switches per DB9)
• Terminal 1 x DB9 Male (LCD Terminal Connector from Com2)
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2) µEEP-5 / µEEP-10 Component Face Plates with Pin-outs

NOTE: Because µEEP-5 / µEEP-10 data acquisition systems are available in many user-specified
configurations, features may be different on your system. Please feel free to contact your nearest
CORRSYS-DATRON representative for any information you may require.

a) µEEP-5 System Faceplate (version 1)

14 - Autofeed

Ground terminal

Parallel input
Keyboard input

Switch

COM 1

1 - Clock
2 - Data
3 - N.C.
4 - GND
5 - 5 Volts
Shell - Shield

Standard Keyboard
Connector for User
Input

Keyboard

Ground Terminal
DC/DC Converter
Ground Attachment
to prevent ground
loop effects

1 - Input 1
2 - Input 2
3 - N.C.
4 - 15 V, 300mA.
5 - Supply GND

Switch Connector
TTL Compatible
0...15 VDC Input V
Thrshld level 2V
Min. input pulse time 100us.
Max. input frequency 3kHz.

Switch DB-9 Male

5 Pin DIN FemaleCOM 1
RS-232 Serial Port
For connection to
Modulab or
Datron DLS Sensor

1 - DCD
2 - RxD
3 - TxD
4 - DTR
5 - GND
6 - DSR
7 - RTS
8 - CTS
9 - RI

LPT1 Parallel Port
Interface for data
transfer or printer
output

1 - Strobe
2 - D0 15 - Error
3 - D1 16 - Init
4 - D2 17 - SI
5 - D3 18 - N.C.
6 - D4 19 - N.C.
7 - D5 20 - N.C.
8 - D6 21 - N.C.
9 - D7 22 - N.C.
10 - Ack 23 - GND
11 - Busy 24 - GND
12 - Paper End 25 - GND
13 - Select

Parallel

DB-9 Male

DB-25 Female

Typical switch input assignments:
Input
2 = pickle switch
3 = brake switch
4 = light barrier
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b) µEEP-10 System Faceplate (version 1)

AAVVAILABLE SOONAILABLE SOON
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c) µEEP-10 System Faceplate (version 2)

AAVVAILABLE SOONAILABLE SOON
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d) µEEP System Front

e) µEEP System Back

Power Switch

Reset Switch

Power
Monitor

CD-R Drive

Removable
SCSI Hard Disk

AC Power Connector
110 VAC. 60 Hz.
220 VAC. 50 Hz.

12 Volt DC
Power Connector

Keyboard / Mouse
Connector
Display
Connector

Standard VGA
Connector
10/100 Mbps
Ethernet Connector

4 Switch Inputs and
Power Output

Terminal Output /
LCD Connector

Com 1
Connector
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f) µEEP Counter Faceplate

Counter

1 - N.C.
2 - INPUT 1
3 - N.C.
4 - 15 Volt (+) 300mA
5 - Supply Ground
6 - N.C.
7 - 5 Volt (+) 300mA
8 - INPUT 2

Counter DB9 Male

RS 484 Compatible
± 30 Volt max.
1.5V Threshold
40 Khz. max. frequency
1 ms. min. pulse width
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g) µEEP J1850/SCE/OBD Faceplate

1 - INPUT 1
2 - INPUT 5
3 - INPUT 2
4 - INPUT 6
5 - Supply Ground
6 - INPUT 3
7 - INPUT 7
8 - INPUT 4

Analog DB15HD Female

Single  Ended Inputs &
Digital Control for
Multiplexor Module

10 - Analog Ground
11 - OUTPUT D0
12 - OUTPUT D1
13 - OUTPUT D2
14 - OUTPUT DS
15 - 15 Volt (+) 300mA
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h) µEEP CAN Faceplate

CAN DB9 Male

Standard Car Area
Network, DCS-CAN
Protocol Connection
Note: Termination At
Both Ends - 124 W

1 - N.C.
2 - CAN_L
3 - GROUND
4 - 12V Supply
Ground
5 - N.C.
6 - N.C.
7 - CAN_H

CAN
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i) µEEP Analog AD1 Faceplate

Analog 6 Pin Lemosa Female

Differential Input
± 10 Volt Input Max.
35 VDC Over-Voltage
12 or 16 Bit Resolution

Analog

1 - 5 Volt (+) 300 mA
2 - 12 Volt (+)300 mA
3 - INPUT NEG. (-)
4 - N.C.
5 - INPUT POS. (+)
6 - Supply Ground

Maximum input over voltage protection for the 6-pin Lemo inputs on the AD1 faceplate is ±24 volts per
input bank 1-4, 5-8, 9-12 and 13-16. Maximum draw on the 12-volt excitation for each input bank 1-4,
5-8, 9-12 and 13-16 is 300mA. Maximum draw on all 16 channels for the 5-Volt excitation is 750mA.
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j) µEEP Analog AD2 Faceplate

1 - INPUT 1
2 - INPUT 5
3 - INPUT 2
4 - INPUT 6
5 - Supply Ground
6 - INPUT 3
7 - INPUT 7
8 - INPUT 4

Analog DB15HD Female

Single  Ended Inputs &
Digital Control for
Multiplexor Module

10 - Analog Ground
11 - OUTPUT D0
12 - OUTPUT D1
13 - OUTPUT D2
14 - OUTPUT DS
15 - 15 Volt (+) 300mA
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k) µEEP Analog AD2s Faceplate

1 - INPUT 1
2 - INPUT 5
3 - INPUT 2
4 - INPUT 6
5 - Supply Ground
6 - INPUT 3
7 - INPUT 7
8 - INPUT 4

Analog DB15HD Female

Single  Ended Inputs &
Digital Control for
Multiplexor Module

10 - Analog Ground
11 - OUTPUT D0
12 - OUTPUT D1
13 - OUTPUT D2
14 - OUTPUT DS
15 - 15 Volt (+) 300mA
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Volume II: Using TurboLab 2000
1) Overview of TurboLab 2000

This manual supports TurboLab v1.78 and TurboLab 50 v5A.

TurboLab 2000 is a Windows 2000* based data acquisition software package.

The following five set-up steps MUST be completed before you can acquire data.
1. Set-up files to save data from the data acquisition signals.
2. Set-up converters to change raw voltage signals from sensors into engineering units.
3. Set-up signals or input channels to receive the raw voltages from the sensors.
4. Set-up an Online or LCD display to visually verify that data is being acquired.
5. Set-up start and stop triggers unless you want to acquire data from the time you start the

test to the time you manually stop the test.

TurboLab 2000 is unique in its set-up, usage of converters, and saving of data. Unless you are very
familiar with data acquisition software, we suggest you follow this manual in the order it is presented.

Note: This manual describes each TurboLab 2000 process or task, step-by-step, illustrated with
screen prints. A box around text indicates a button to click or a key to press. A capital letter at the
beginning of each word in a text string indicates a label describing a part of a dialog box or a choice
to be selected from a menu or list in a dialog box. Quotation marks indicate text that is to be typed
by the user. Do not include the quotation marks.

*Windows 2000 is a registered trademark of the Microsoft Corporation.
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2) Creating a storage directory for TurboLab 2000 data

1. Prior to opening TurboLab 2000, we strongly suggest that you create a directory in which
your data files will be stored. (We suggest you create the folder on your c:\root directory.)
Open My Computer from your desktop. Double-click on the C: drive icon to open a window
for your C:\drive. Right-click in the background of this new window and select New from the 
menu that pops up. Select Folder from the new menu.

2. Name the new folder appropriately.

3. For demonstration purposes, this new folder is named Training.
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3) Opening TurboLab 2000

1. Open TurboLab 2000 from the Start menu. Select Programs, then select the TurboLab Online 
folder, then select the TurboLab 2000 program.
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4) TurboLab 2000 job categories

In this training example our job file is named Training_Job, which is the name you see at the top of
the projects window. The projects window is shown below on the left side. It will display the six cate-
gory selections shown below when you first create a new job.

Note: Once you have created a signal channel, a drivers category will be added automatically, so
typically, you will never have to change any of the settings in this category.

Signals: This is where you will create signal channels coming in from sensors.
Files: This is where you will create sections of signal channels you want to collect

data from. This is also where you will select sampling rate.
Layouts: This is where you will select LCD display signals and create online displays.
Tables: This is where you will create data table files.
Converters: This is where you will create converters for converting sensor inputs into

engineering units.
CAN Messages: This is where you will create CAN message signals to acquire CAN data from

AN based sensors or data acquisition equipment.
Drivers: This is where TurboLab 2000 automatically loads the hardware drivers to run 

TurboLab 2000.
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5) Menus in TurboLab 2000

The following are the available commands in each of drop-down menus in TurboLab 2000. 
Note: Not all menu functions will be available at any given time.

The File menu

New Creates a new job.
Open Allows the user to open an existing job.
Save Saves the current job as the current name.
Save as… Allows the user to save the current job under a different name.
Import CAN db… Allows the user to import a CAN database.
1,2,3,4 History List – Last 4 jobs opened.
Exit Closes TurboLab 2000 – TurboLab 2000 will ask the user to save

any unsaved settings.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 23

The Edit menu

New Creates a new item in anything currently selected.
Delete Deletes the current selection.
Paste Inserts content previously copied to the clipboard.
Copy Copies selected contents to the clipboard.
Cut Deletes selected content and copies it to the clipboard.
Undo Undoes any changes made.
Redo Redoes any Undo’s.

The View menu

Toolbar Shows or Hides a bar at the top of the TurboLab 2000 window that provides
buttons for: NEW, OPEN, SAVE, CUT, COPY, PASTE, PRINT, HELP.

Statusbar Shows or hides a bar at the bottom of the TurboLab 2000 window that
indicates problems or state of program.

Project window Shows or hides the window on the left side shown below.
Log window Shows or hides a TurboLab 2000 Log status window at the bottom, providing 

program status and error messages.

We suggest that you have the statusbar and project window showing all the time.
TurboLab 2000 will come installed and set-up with this configuration.
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The Job menu

Start Starts TurboLab 2000 data acquisition.
Calibrate Calibrates the input signals.

The ? Menu

About TurboLab 2000 Opens an information window with version number and copyright information.

Below is the About TurboLab 2000 Window at the time of this publication.
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6) Creating a new job in TurboLab 2000

1. By default, TurboLab 2000 automatically brings up the last job you had open.
Note: TurboLab 2000 does not allow more than one job to be open at a time.

2. Open a new job from the File menu. Next, save this new job from the File menu. The job name 
may be something related to the date and test that you will be running. (For all future saves, 
once you have renamed the default job, you can simply press the control key Ctrl and the S key 
simultaneously. This should be done after each change or addition made in TurboLab 2000.) We
have selected the newly created folder on our hard drive and have named our file 
Training_Job.tlb. Your job files will have the extension of .tlb. It is strongly recommend that you 
use no spaces in any of the names given to files, signals, or converters. Instead, use under
scores to avoid any unwanted effects on converter names.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 26

7) Opening a job in TurboLab 2000

1. Click on the File menu and click Open.

2. Using the drop-down button (the arrow) on the "Look in:" line or the up folder button,
select the job file.
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8) Setting up a location for automatically saving
job and data files

1. Double-click on the name of your job file in the left windowpane. You will see two tabs near
the top of the right windowpane: General and Job.

2. Enter the path of the folder, including a backslash at the end, on the File Name line or click on 
the … button and use the Save As window shown below to select the folder in which you want 
to save your data files. Then, add the file name. Note that we have added an underscore at the 
end of the file name. This will allow us to better see the incremental numbers that TurboLab 
2000 automatically adds to the end of each file name. The complete path can be seen in the 
above window. 

• The Current Nr selection lets you start the automatic incremental numbers at any number 
you like. You can also use this window to see what number will be added for your next 
saved test data. This is a good way to check the number of the last test data taken.

• The Query After Test option controls the way test data is saved. If the check box is not 
selected, test data is saved automatically at the end of the test. If the Query After Test 
option is selected, you will be queried as to whether or not you wish to save data at the end 
of each test. You will also have to option to edit filename and path at this time.
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Once you have named the data file, select Save from the File menu and save your job.\
You will see that the name of your job will now change to the file name you chose.
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9) Setting up converters

1. The first step when setting up any job in TurboLab 2000 is to set-up your converters. This can 
be done two different ways. The first is by opening two instances of the TurboLab 2000 program,
then dragging and dropping previously made converters from the project window of the former 
job to the project window of the new job. The second way, demonstrated here, is to make new 
converters. First, click on the + sign button to the left of the job icon in the Project Window. You 
will immediately see the following six sub-categories: Signals, Files, Layouts, Tables, Converters 
and CAN Messages.

Note: Once you create signal channels, the driver sub-category will be added automatically, 
along with any drivers needed to support the type of signal channel you have created.

2. Right-click on Converters and select New. The following pop-up window will open, providing two 
choices. LinearScale and Polynomial. Note that Polynomial is true polynomial. For this converter,
select LinearScale and click OK.
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3. Next, you will see the window below. 

4. Double-click on Converter1 to open the properties window below. This is where you will name 
and set-up a converter.
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5. First, rename the converter (in this example, "H7_Height_Sensor") and click on the Apply button.
This will update the converter with your new name.

Note: Always click the Apply button to update any changes you make to any of the properties.
Note: No spaces should be used in naming the converter. Use underscores to separate words.

6. Click on the Conversion tab at the top of the right pane, and enter the conversion input data by 
clicking on the box with the triple periods … at the end of the Input line.
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7. Reference your sensor’s voltage output range. Enter the minimum output voltage value in the 
Minimum line. Enter the maximum output voltage value in the Maximum line. Scroll down using 
the scroll bar on the right side of the Units window and double-click on the voltage symbol 
shown highlighted below. Click the OK button when done. This enters the data in the input line 
of the Conversion window.

Note: If you need a smaller derivative of a unit, click on the + sign next to the basic unit.
Ex. The + next to "V" will show you mV, mV, kV, MV as selections.

8. Next, click on the triple period button … at the end of the Output line. Enter the minimum and 
maximum range values of the units you want the converter to use. Using the scroll bar, select 
the unit you want the converter to use for output data. Click the OK button when done.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 33

9. After entering the conversion data, click on the Apply button and TurboLab 2000 will
automatically calculate the conversion formula necessary to provide the correct output 
unit data to be requested from the sensor’s input voltage.
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Make a distance converter for a Counter channel.

1. Right-click on Converters, select New, and select LinearScale, then click OK.
2. Double-click on Converter1, rename the converter as Distance, and then click Apply.
3. Click on Conversion and click on the … Input box. Enter 0 in Min and 400 in Max.

Leave the Unit box empty. Then, click OK.
Note: Any converter that has no units selected will only be usable in a Signal Counter channel. 
Note: ONLY Converters that have no unit selected in the input range will be available for use 
in Signal Counter channels.
(These are the pulses that the counter channel will be counting and converting into meters.
The CORREVIT® L400 Sensor used for this example outputs 400 pulses per meter traveled.)

4. Click on Conversion and click on the … Output box. Enter 0 in Min and 1 in Max.
5. Double-click on the small "m" for meters, located at the top of the engineering units selection 

box below. This will add meter as an available selection in the Unit box.
6. Click OK.
7. Click Apply.

With the above steps completed, you should see the above window with the formula 
E*0.0025(m) in the grayed out Charact. box, as shown above. You will use this converter in
the next step.

Repeat this process for each of the converters required for the specific test you will be performing.
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10) Setting up signal inputs

a) Analog input

1. Right-click on Signals and select New. You will see a complete list of all of the possible choices 
for your signal channels. (The window on the right shows the bottom half of the selections once 
you have scrolled down.)

2. Select the type of signal you will be acquiring data from. For this set-up we have selected 
Analog Input from the Corrsys-Datron H-7 height sensor. Once you have made your selection, 
click OK .
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3. The type of signal you have selected appears in the Name field, numbered sequentially. This is 
a generic signal channel name and must be changed. To do so, double-click on the new Analog1
signal channel you have made.

4. Rename the signal and click Apply. In this example, we have renamed our signal channel
Right_Side_Height.
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5. Click on the A/D Channel tab at the top of the right windowpane. Click on the down arrow at the
end of the Conversion line and select the converter you would like to use for this signal. For this
example we have used the H7_Height_Sensor.

6. Once you have selected the converter, click on the Apply button to enter your selection.
Note that once you have clicked on the Apply button, TurboLab 2000 automatically enters the 
conversion data into your signal settings.
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7. Because the converters currently only understand gain that is expressed as both positive and 
negative voltages, the converter will generate a height range setting of -200 to +800 mm, as 
shown above. The input gain range of the sensor must be changed manually, back to a positive 
voltage range of 0 to +10 volts (the output range of the H-7 sensor). Therefore, height range 
should be 300 to 800 mm. Do this by clicking on the … button at the end of the Range line. 
Enter 300 in the Minimum line and 800 in the Maximum line.

8. You will also need to reselect the mm Unit selection using the scroll bar at the right of the Range 
input window. Once selected, click on the OK button.

9. This will reset the input voltage of the converter to the sensor’s output. Click on the Apply button   
to enter this new data.

Repeat this process for each of the analog input signals required for the test you will be performing.
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b) Counter Input

1. Right mouse click on Signals and select New. You will see a complete list of possible choices for
your signal channels. (The window on the right shows the bottom half of the selections once you
have scrolled down.) Select Counter Input and click OK.

2. Under the General tab, rename this new Counter Channel as L400_Distance, then click Apply.
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3. For this example, we will set up a Distance and Speed channel using the digital output from the 
same L-400 Sensor. To do so, begin by clicking on the Counter Channel tab.

4. Select the channel that the digital pulse signal will be coming in on. Usually, this will be #1.
The Type will be Distance. Select this from the drop-down menu by clicking on the down arrow 
at the end of the blank Type box.

5. Click on the down arrow on the Conversion box. Distance should be the only available selection.
Select it and click Apply.
Note: The Range entry changes when you click Apply. This setting must be changed manually 
in the following step.

6. Click on the … button at the end of the Range line and enter 100000 in Max, and m in the Units, 
then click Apply again. This completes set-up of the Distance input channel from the L-400 Sensor.

Note: The value you enter in the Range line will be the maximum value that the software will 
record.  Any value beyond the entered value will be clipped or cut-off, and only the maximum 
value will be saved. Data points beyond the range of the entered value will not be saved.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 41

Setting up a speed channel from the same sensor

1. Right-click on Signals and select New, then select Counter Input and click Apply. Double-click on
the Counter1 signal that was added. Rename this signal "L400_Speed" and click Apply.
Note: If you do not click Apply, you will be prompted per the screen print below.

2. Click on the Counter Channel tab at the top of the right window.

3. Select the same channel used for the Distance channel input. (Typically channel #1.)

4. Select Speed from the drop-down menu at the end of the Type box.

5. Select Distance from the drop-down menu at the end of the Conversion box.

6. Click on the … button at the end of the Range line, enter 0 in Min and 400 in Max, then click OK.

7. Enter kmh in the Units by using the scroll bar at the right side of the engineering units box.
The kmh selection is almost at the bottom.
Note: If you need mph or both mph and kmh, this will be discussed on the next page.

8. Click Apply again. This completes set-up of the Speed input channel from the L-400 sensor on 
channel #1.

Repeat this process for each of the counter input channels required for the test you will be performing.
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c) kmh vs. mph units output

TurboLab 2000 automatically converts from metric to English units once you have set-up the correct
converter with the units that the sensor is supplying via its voltage output. In this example, the L-400
sensor produces 400 pulses per meter. It is not necessary to create a new converter to translate
meters into feet or miles. We can simply create a new counter channel that uses miles as range
units, or change the range unit in the original counter channel we created. TurboLab 2000 will auto-
matically convert meters into miles in the input channel.

To create a mph speed channel it is necessary to manually convert the sensor’s units range into the
new units you want to use. In this example, the L-400’s range is 0 - 400 kmh. We will have to con-
vert 400 kmh into a mph value, which is 248.5 mph.

To do so Click on the … button at the end of the Range line, enter 0 in Min and 248.5 in Max and
click OK. Then, enter mph in the Units by using the scroll bar at the right side of the engineering
units box.

This will provide the correct range of the sensor in mph. TurboLab 2000 takes the Distance convert-
er we created and converts the meters unit into miles.
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d) Switch Inputs
1. Right-click on the Signals and select New.
2. Select Switch Input and click OK.
3. Double-click on the new Switch1 signal. Rename this signal "Light_Barrier" and click Apply.
4. Click on the Switch Channel tab at the top of the right window. 
5. Select the switch input to which the Light_Barrier signal is attached.

Note: Typically, the following Switches will be pinned out with 9-pin D-subs to the following 
switch inputs:
Input #1 = Available
Input #2 = Pickle switch
Input #3 = Brake switch
Input #4 = Light Barrier
Repeat this process for each of the switch input signals required for the test you will be performing.

e) Trigger Signals
There are three types of triggers: Threshold, Expression, and Switches.

Threshold triggers are used to activate a trigger 
when a predetermined threshold value is passed.

Expression triggers combine two triggers or
switches to create a combined trigger.

Switches can also be used as triggers. There is no 
need to set-up a trigger channel to use a switch as 
a trigger.
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i) Threshold Trigger

1. Right-click on the Signals and select New.

2. Select Trigger.

3. Click on the + sign button and select Threshold, and then click OK. 

4. Double-click on the new Trigger1 signal. Rename this signal "60mph_Trigger", and then click Apply.

5. Click on the Trigger tab at the top of the right window. 

6. Select the switch input you want this trigger to use (in this example, the L-400_Speed [mph] signal).

7. Select the Operation you want the trigger to have. Six options are available:

EQ – Equal to
NE – Not Equal to
GT – Greater than
GE – Greater than or Equal to
LT – Less than
LE – Less than or Equal to

For this example, select LE, Less than or Equal to, from the drop-down menu.

8. Click on the … button and enter "60 mph".

9. Click on the Threshold passing option. This will activate the trigger only when you pass through 
60mph from above to below. It will not activate the trigger when you pass through 60mph from 
below.

10. Click Apply.

Note: Click the Threshold passing option if you want the trigger to activate only when you pass 
through the trigger’s value from the operation’s value.

Repeat this process for each of the threshold triggers required for the test you will be performing.
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ii) Expression Trigger

An Expression trigger combines two triggers into one trigger.

1. Right-click on Signals and select New.

2. Select Trigger.

3. Click on the + sign and select Expression.

4. Double-click on the Trigger1 signal that was added. Rename this Trigger signal 
Expression_Trigger and click Apply.

5. Click on the Trigger tab at the top of the right window.

6. Select the Trigger or switch input you want to use for trigger #1.

7. Select the Operation you want this expression trigger to have. There are two options available:     
"Or" – trigger condition for either trigger #1 or trigger #2 must be met to activate the trigger.
"And" – trigger conditions for both trigger #1 and trigger #2 must be met to activate the trigger.

8. Select the trigger or switch input you want to use for trigger #2.

9. Click Apply.

Note: Click the Threshold passing option if you want the trigger to activate only when you pass 
through the trigger’s value from the operation’s value.

Repeat this process for each of the expression triggers required for the test you will be performing.
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f) LCD Button Inputs

An LCD Button input uses one of the buttons on the LCD display as either a switch or a trigger.

1. Right-click on Signals and select New.

2. Select the LCD Button.

3. Double-click on the new Trigger1 signal. Rename this signal LCDBtn_Red and click Apply.

4. Click on the Button tab at the top of the right window.

5. Select the color switch you want to use. Three options are available:

Red 
Yellow
Green 

For this example, select Red.

6. Click Apply.

Repeat this process for each of the LCD button signals required for the test you will be performing.
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g) Time Channels

A Time signal input is used to create a time base for your data.

1. Right-click on Signals and select New.

2. Select Time and click OK.

3. Double-click on the new Time1 signal.

4. Click on Post Trigger (or Total).

Click on Post Trigger if you want the time baseline to reset when the start trigger is activated. 
This is necessary if you are using a time trigger and want to run a test for a specific amount of time.

You can have multiple time channels, which are needed if you want both overall time and
triggered test time.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 48

h) Calculated Channels

A Calculated Channel input uses other signal channels and then performs a real-time calculation 
on the signal or signals used to provide the desired the output.

1. Right-click on Signals and select New.

2. Select Calculated and click OK.

3. Double-click on the new Calculated1 signal. You will see the window below. 

4. Click on the … button next to the formula box. This will bring up the following window.

Note: For complete explanations of each available formula, see Formula Helper in Appendix D.
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5. You can expand each of the above selections by clicking on the + next to the formula heading. 
All of these expansions are listed in Appendix E, Formula helper. Under the first formula heading
you will see the label Signals. This will list all of the signal channels you have set-up. This allows
you to add the signal you want to the formula you are creating. cted formula to the formula window.

6. Now, simply highlight the given input variables and Click on the … button next to the formula box.
This will bring up the Formula Helper window again.

7. Expand the Signals and highlight the signal you would like to add in that signal value of the formula.

8. Once you have added all of the required signal channels using the methodology above, simply 
click on the Apply button.

Repeat this process for each of the calculated signals required for the test you will be performing. 
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11)Calibrating Signal Channels

1. Click on the Job menu.

2. Select Calibrate.

3. Select the signal channels you want to calibrate by checking the box next to the signal channel 
name and then clicking OK.

4. The window below will list the signal channels that are to be calibrated, as well as the current 
values that TurboLab is reading from the sensors.

5. Click on the Calibration menu and select Start.
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6. Once you are satisfied that TurboLab 2000 has monitored and recorded the calibration, click on 
the Calibration menu and select Stop.

7. This will bring you back to the TurboLab 2000 set-up windows. If you now click on any of the 
signals you have just calibrated, you will see that TurboLab 2000 has added the calibration off
set to those signal channels.

Note: Because the Right_Side_Height signal channel has been calibrated, you will see that the
calibration has been added in the Calibration Offset box to the right of the set-up fields.
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12)Setting up Files

This is the data you want to save during acquisition testing. This data is completely independent of
the data that is shown on the LCD or the Online display. This is where you will set the sampling rate
for the data you to be acquired.

1. Right-click on the Files and select New. This will create a new file called Section1.

2. Double-click on the new Section1 category. This will bring up the window below.

3. Use the Start trigger drop-down menu to select the start trigger you previously set-up.
This will be the trigger that activates the data saving file.

4. Use the Stop trigger drop-down menu to select the stop trigger you also previously set-up.
This will be the trigger that stops the data saving file. Note: TurboLab will drop out of the data 
Acquisition mode once the stop trigger is reached, unless you have selected to collect multiple 
jobs within the same file. If you set the software to collect multiple jobs within the same file, 
TurboLab 2000 will be armed and waiting to see the start trigger to start saving the second
section of your data file.

5. Click on … to set the sampling rate in the Frequency line.
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6. The Nr of Jobs allows you to acquire more then one set of data under a single job name.
Click + to increase the value and - to decrease the value.

7. You can also save the data up to 5 seconds before and/or after the triggers using the Pre trigger 
and Post trigger settings.

8. Click on the + next to Section1.

9. Right-click on the Selected Signals and select New:

10. Select the signal channels you want to save in your data acquisition file by checking the box 
next to the signals name and clicking OK.

11. Make sure you have set-up a file name for your data file. If you have not, see Section 6) 
Creating a new job in TurboLab 2000.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 54

13)Setting Sampling Rate

You can set the sampling rate for a set of signals you are saving. If you need different sampling
rates for your data, you will have to set up two file sections, set your sampling rates, and then com-
bine the data, post test.

1. Double-click on the Section that you want to edit or set the sampling rate in.

2. Click on the Section tab at the top of the right windowpane.

3. Edit the sampling rate under Frequency by clicking on the … at the end frequency line.

Note:
The maximum sampling rate is 1 kHz.
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14)Setting up Layouts

This is the data you will want to view during your acquisition testing. This data is only shown on the
LCD monitor and/or the CRT.  Note: This is not the data that you will be saving to analyze later. Your
data acquisition file for later viewing is set-up in the files set-up.

Setting up the Online display

These are all the possible objects to select for your online display. 
Digital Value – Displays information as a numerical value.
Time Chart – Displays information as line graph. (Like a Plotter Grapher would.)
Analog Meter – Displays information as an analog gauge. (Like an analog speedometer.)
Bargraph/Level – Displays information as a rising and falling line against a gauge.
LED Control – Displays information as green or red circle.
Multiple Bar – Displays information from multiple sources in one window.
Digital Clock– Displays information from a time signal channel.

Below is a sample of each type of display object. Each is shown in the default size.
All can be resized and titles/labels can be changed.

Note: When you create more then one new display object at a time before moving the previous
object, the new object will be placed over the top of the previous one. All new objects are placed in
the upper left hand corner of the page they were created in.
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1. Right-click on Layouts, then select Online Layout.

2. Page1 will appear as a sub-line under Layouts. Click on the + to the left of Page1.
Objects will appear as a sub-line under. Right-click on Objects and select New.

3. Select Digital Value from the window below and click OK.
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4. Double click on the Digital Value1 in the Label box.

5. Using the drop-down menu, select the signal you would like to monitor in this object. For this 
example, select the "Right_Side_Height" signal. TurboLab 2000 will automatically enter the
signal name in the label line. You can change or edit the label to whatever you would like.

6. Using the … button set the range that the object should display data in. For this example, use 
the range of the H-7 Height sensor, which is 300-800 mm. You can only display the data in an 
engineering unit that has been selected in the signal that the data is being pulled from. Once 
done, click the Apply button.

7. To move or resize a display object, you must first double-click on the Page1 selection. This will 
bring up the display object edit window in the right windowpane.
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8. Click on the display object. This will bring up eight small boxes, called handles, around the 
object. To resize the object, move your mouse over one of the handles until the mouse pointer 
changes from a pointer to either an angled or straight line with an arrow at each end. The corner
handles allow you to resize the object vertically and horizontally simultaneously, while the side 
handles will only resize the object in one direction at time. To move the object, move your mouse
over the center of the object until the mouse pointer turns into a four-pointed arrow. Then, click 
and hold down the mouse button while dragging the object in the desired direction. Use the 
scroll bars at the side and bottom of the edit window to move objects further.

Note: You can have up to three pages of Online displays.

Repeat this process for each of the layout displays required for the test you will be performing.
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15)Setting up the LCD Display

1. Right-click on Layouts then select Online Layout.

2. LCDPage will appear as a sub-line under Layouts.

3. Click on the +  next to LCDPage.

4. Right-click on the Signals and select New.

5. Select the signals you would like to be displayed on the LCD display.

Note: You can only display four signals on the LCD display at a single time. You can select to 
display up to eight signals. If you select more than four signals, the display will toggle between 
the first four and the second four signals.
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16)Starting your first Job

Once you have set-up all of your Converters, Signal input channels, Files for saving data, Online
and/or LCD displays, and triggers you are ready to start testing and acquiring data.

1. Click on the Job menu.

2. Select Start.
• TurboLab is now armed, or active, but has not yet started to acquire data. Note the lower right 
hand corner of the online display. There, the message, "Waiting", and a clock that is counting 

will be displayed.
• Once the start trigger is activated this will change to "Saving" and the clock will display the 

elapsed time since the start trigger was activated.
• On the lower left hand corner of the online display you will see the file name and the incre

mented test number that your test data is being saved under.

Good Luck.
Corrsys-Datron Sensorsystems, Inc.
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Appendix a)
TurboLab Scope of Delivery

i) TurboLab 2000
TurboLab 2000 requires either of the following set of program and associated file for complete 
installation.  All of these files can be found on the Datron1 Server, under programs, in the folder 
labeled TurboLab_Programs, TurboLab_2000_1_76 (1.76 is the latest version at the time of this 
writing, See Corrsys-Datron Tech. Support personal for current version if unsure.)

tl2000.exe
tl2000.W02
tl2000.W03
tl2000.W04
TLUNITS.ULB
AEP5.SYS
AEP5.DLL
AEP5_1b.reg
AEP5_2b.reg
AEP5_3b.reg
TurboLabManual2_15.doc

OR

tl2000_tot.exe
TLUNITS.ULB
AEP5.SYS
AEP5.DLL
AEP5_1b.reg
AEP5_2b.reg
AEP5_3b.reg
TurboLabManual2_15.doc

ii) TurboLab 5.0
TurboLab 5.0 requires either of the following set of program and associated file for complete 
installation.  All of these files can be found on the Datron1 Server, under programs, in the folder 
labeled TurboLab_Programs, TurboLab 5.0 Analysis Ver4Q (5.0 4Q is the latest version at the 

time of this writing, See Corrsys-Datron Tech. Support personal for current version if
unsure.)

tl50_setup.exe
ol5import.inf
ol5import.dll
TurboLabManual2_15.doc
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Appendix b)
TurboLab 2000 System Requirements

Minimum system requirements to run TurboLab 2000

Operating system: Windows 2000

CPU: Pentium-based computer with 700MHz processor
Recommend Pentium III 

Memory: 64MB
Recommend 128MB

HD: Minimum 100MB for installation and storage of data files

Other: Recommend removable storage, i.e. Zip drive or CD-R drive.
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Appendix c)
TurboLab 2000 Software Installation
Before you start, you must determine if you have an existing version of TurboLab 2000 installed on
your computer. Any existing version must be removed prior to this installation.

To do this, simply open Explorer and search for a file named TurboLab 2000.exe. If you find
TurboLab 2000.exe, you must uninstall it before you install the new version you have. Please start at
step #1.

If you find no previous version, please proceed directly to Step #4.

Step 1:
Back-up existing TurboLab 2000 files and data:

You will need to back up any files that you have saved into the C:\Program Files\TlOnline folder. 
These include TurboLab 2000 setup files (.tlb) and data files (.dol). Copy these to a different 
directory before proceeding with the next step. Everything in the TlOnline folder will be deleted when
you uninstall TurboLab 2000 in preparation for installing the newer version.
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Step 2:
Copy TurboLab 2000 to your Computer:

Copy ALL of the files you have received into a folder on your c:\ drive or locate them on the 
installation CD. We suggest you create a directory called TurboLab 2000 Software on your C:\ 
drive root. For the new version, you should have received the following files:

tl2000.exe
tl2000.W02
tl2000.W03
tl2000.W04
TLUNITS.ULB
AEP5.SYS
AEP5.DLL
AEP5_1b.reg
AEP5_2b.reg
AEP5_3b.reg

OR

tl2000_tot.exe
TLUNITS.ULB
AEP5.SYS
AEP5.DLL
AEP5_1b.reg
AEP5_2b.reg
AEP5_3b.reg

Note: If you received a file with a .zip file extension, you must first extract the files from the zipped
file using the WinZip program. If you need assistance, please contact your information systems
department or Corrsys-Datron Sensorsystems Inc. at  (248) 204-0850 and ask for Technical Support.
If you received a self-extracting zip file, simply execute the .exe file and follow the prompts, then
save the TurboLab setup files per above.
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Step 3:
Uninstall Any Existing Versions of TurboLab 2000:

Using the Start Menu, EXECUTE the Uninstall program.

Make sure that "Automatic" is selected and click Next.
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Click Finish.

If the Uninstall program asks you if you want to delete or uninstall any associated files or files that
will not be used any longer by any program, click Yes All. If prompted by the warning message that
this action might affect the operation of other programs and are you sure, click Yes or OK and delete
all of the files. They will be replaced by the new version of TurboLab 2000 you will be installing.
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Step 4:
Install the New Version of TurboLab 2000:

Double-click TL2000.EXE or TL2000_tot.EXE.

All programs should be closed before continuing. The computer must be restarted after the TL2000
installation process is complete.

TL2000 will now ask for your name and company information, unless it was previously installed.
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Click Next to install the program in "C:\Program Files\TLOnline", which is the default folder.

A list of available drivers will appear. 
Check all appropriate drivers for the hardware that is installed in your uEEP-5.
NOTE: Virtual Channels and uEEP-5 Hardware selections must be checked.
Datron LCD – Installs necessary driver for the Heads-Up LCD display.
Softing CAN Bus – Installs necessary drivers for use with the Softing CAN card.
Vector Can Lib – Installs necessary drivers for use with the Vector CAN card.
HiCONCAN PCI – Not used on uEEP-5 systems.
J1850 Bus – Installs necessary drivers for use with the J1850 (vehicle bus / OBD bus) card.
BMC PCI Base – Not used on uEEP-5 systems.
Quatech PCMCIA – Not used on uEEP-5 systems.
Select the appropriate drivers and then click Next.
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Click Next to start the installation process.

The installer will now copy all necessary files and create the program groups and icons.
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Click Finish to complete the installation process.

Click OK to restart the computer.

If you are not prompted to RESTART, please manually RESTART your computer using the START
menu, select "Shut Down", then select "Restart the computer?" option.
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Once your computer has restarted, you will need to copy the "AEP5.SYS" files into the "C:/Program
files\Tlonline" folder To do this, Open the "Start" menu, and select "Programs", then the "Windows
Explorer" program.

Locate the folder where you found the Tlonline_tot.exe file. You should find a folder called
"AEP5_02_12_02". Within this folder, locate and copy the file "AEP5.sys" to the "C:/Program
files\Tlonline" folder. You should now have a window that looks something like the window above.
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Click on the Start menu and select RUN.

In the Run box, type "regedit" and click OK.

Click Registry and then select Import Registry.
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Locate and select one of the following three registry files depending on how many analog cards you
have installed in your uEEP-5 or uEEP-10.

AEP5_1b.reg – for 16 analog channels
AEP5_2b.reg – for 32 analog channels
AEP5_3b.reg – for 48 analog channels

Once selected, click Open.

You will receive the above message window upon successful importation into the registry.

You will now have to RESTART your computer so that the operating system will load the new
AEP5.dll driver you just coped, and will load the new registry entry you just imported.

Upon restart you will be ready to use TurboLab 2000.

If you also need to install TurboLab 5.0, Please proceeded to the next section of this appendix.
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Appendix d)
TurboLab 5.0 Software Installation

Step 1:
Copy TurboLab 5.0 to your computer.

Create a folder on your c:/root directory, name it "TurboLab_50", and save all three of the files listed
below to the new folder:

tl50_setup.exe

Note: If you received a file with a .zip file extension, you must first extract the files from the zipped
file using the WinZip program. If you need assistance, please contact your information systems
department or Corrsys-Datron Sensorsystems Inc. at (248) 204-0850 and ask for Technical Support.
If you received a self-extracting zip file, simply execute the .exe file and follow the prompts, then
save the TurboLab setup files per above.

Step 2:
Install TurboLab 5.0.

Locate the file tl50_setup.exe and double-click on it to execute the setup insulation program.

Click Next.
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Click Next to install TurboLab5.0 in the default directory, shown above.

Click Next.



User Manual µEEP-5 / µEEP-10 Data Acquisition Systems with TurboLab Software

© 2003 CORRSYS-DATRON Sensorsysteme GmbH, Wetzlar, Germany 3/03 77

TurboLab 5.0 is now being installed on your system.

Click Finish to exit the installation.

Note: You may be prompted to restart Windows* to complete the installation. If so, restart your computer
by clicking OK. Do not attempt to run TurboLab 5.0 without restarting. This will corrupt your registry file.
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Step 3:
Open TurboLab 5.0 for the first time and enter serial Number.

All Install windows must be closed before proceeding.

Open TurboLab 5.0 from the Start menu.

You will be prompted with the following message. Click OK twice.
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When you open TurboLab 5.0 for the first time, you will be asked what language you would like to
use. Select English and Click OK.

Next, TurboLab 5.0 will prompt you to enter your serial number.

Enter the Serial Number provided on your TurboLab Certificate into the space in the window above
and Click OK unless you have been provided with another number.

Note: Please keep this number in your records for any future re-installations, updates, or technical
support. Please do not distribute this software or serial number to anyone.
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At this time, the Tip of the Day Directory has not yet been written. Therefore, we suggest that you
un-select the selector box labeled "Tips anzeigen", or you will be asked to locate and select the Tip
of the Day directory every time you open TurboLab 5.0. Once you have unchecked the "Tips
anzeigen" option, click Schlieben.

Note: It will be necessary to close TurboLab 5.0 to see the menus and window text in English, so
please close and reopen TurboLab 5.0.

Once you have restarted TurboLab 5.0 you will see that all of the Menus are now in English. Please
proceed to Step 4.
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Step 4:
Installing the correct .dol filter

Go to the File menu and select Settings\Options… as shown above.

The window above will appear. Select the "File extension" tab at the top of the window.
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In the "File extension" tab, change the .DAT default extension to ". DOL"
(be sure to include the period) and click OK.
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You have the option to install some additional feature items that will allow
you to easer scale, swap data files, and otherwise manipulate your data.

Note: These are mini-TurboLab Scripts and can not be used when you are recording using the
Scripting function in TurboLab.

Open File, Settings, Extra Menu, Load Add-on from file.

TurboLab will
prompt you whether you want to change your existing add-on file, select OK.
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Locate in the C:\Program files\TurboLab\Add-on folder the AddOne.ini file and select the Open button.

Check all of the available options from this new window and click OK. This completes the installation
of the additional features. Descriptions of each are available on the following page.
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Additional Features Descriptions:

The image below shows the Toolbar that will be added at the top of TurboLab window.

These features work only on the active object/signal of your display. The active object/signal can be
identified by looking at the bottom of the TurboLab window and seeing which signal is shown next to
the data file is being used.

Toggle Line/ Bar = Changes the Fill of the active signal with each click.

Change Color = Changes the color of the active signal with each click.

Flip axis position = Moves the active signals axis from one side to the other side of the window.

Toggle Grids On/Off = Turns on or off the grid lines on the entire active window.

Scale Optimization = Calculates the total scale range shown of all of the signals being di played in the 
active window and then adds + and – 5% of that range and regenerates the scales on that value.

Replace Data Files = Replaces an existing data file being displayed in the active window 
with any other data file.

Signal Inspector = Allows you to click through each of a active data files signals.

Transfuse Current X Range = Allows you to change the current X range for another signal in
the active data file.

Equalize Zero levels of Axes = Equalizes all axis of all scales in the Y axes to the same Zero level.

IN EXTRAS MENU (not shown)
Easy View = Allows you to manipulate and generate plot views easily.

This concludes installation and setup. TurboLab 5.0 is now ready to use.
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Appendix e)
Formula Helper

Arithmetic Functions
Mod(a,b) Modulus of a/b
Sign(a) Signum of (a): -1, 0, +1
Abs(a) Absolute value of (a)
Frac(a) Fractional part of (a)
Int(a) Integral part of (a)
Exp(a) Exponentiation (w to the a’th power)
Ln(a) Natural log (base e)
Log(a) Common log (base 10)
Rad(a) Convert degrees to radians
Deg(a) Convert radians to degrees
Sin(a) Sin of a
Cos(a) Cosine of a
Tan(a, b) Tangent of a
ASin(a) Arc Sine
ACos(a) Arc Cosine
Atan(a) Arc Tangent
SinH(a) Hyperbolic Sine
CosH(a) Hyperbolic Cosine
TanH(a) Hyperbolic Tangent
ATan2(a) Arc Tangent of a/b
dB(a) dB scaling: 20*log10(a), clipped at -100
Rand(a) Random number in the range 0…a
Gauss(xq, sd) Normally distributed random number (mean, standard deviation)
Phase(r, i) Phase (in angles) of a complex number
Magn(r, i) Magnitude of a complex number, square root (r2+i2)
V2T Voltage to Temperature, where n = 1 (T-Type) or n = 2 (K-Type)
Sqr(a) Square of a (a*a)
Sqrt(a) Square root of a
Pow(a, n) Power: a to the power of n

Logical Functions
Toggle(a) Edge Detection: T if a changes state, F otherwise
FEdge(a) Falling Edge: T if a changes from T to F, F otherwise
REdge(a) Rising Edge: T if a changes from F to T, F otherwise
OnOff(a) Changes State: (T/F) is a is T
FlipFlop(x, s) Flip Flop with input x and set value s
MonoFlop(x, t) Mono Flop of x with constant duration t
Inside(x, l, h) Returns T if x is within limits
Hysteresis(x, l, h) Hysteresis with input x and on/off l and h

Bit Functions
BitSet(x, m) Status of bits m (bitmask) in x
ClrBit(x, m) Clears bits m (bitmask) in x
SetBit(x, m) Sets bits m (bitmask) in x
Clip(x, l, h) Clips input x at limits l (low) and h (high)
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Signal Filtering
WSum(x, a0, a1, …) Weighted Sum: a0*x + a1*x[-1] + …
Dif(x, t) Difference between current and previous values: x - Lag (x, t)
DyDt(x, t) Dif(x, t) divided by t
MovMin(x, t) Moving minimum of x over window duration t
MovMax(x, t) Moving maximum of x over window duration t
MovSum(x, t) Moving sum of x over window duration t
MovAvg(x, t) Moving average of x over window duration t
MovVar(x, t) Moving variance of x over window duration t
Lag(x, t) Value of x that was acquired in the past

Statistical Functions
Min(x, s) Minimum of x with set input s
Max(x, s) Maximum of x with set input s
Avg(x, s) Average of x with set input s
Sum(x, s) Sum of x with set input s
Memory(x, s) Last value of x where set input was TRUE
Minimum(a, b, …) Minimum value of all supplied arguments
Maximum(a, b, …) Maximum value of all supplied arguments
Mean(a, b, …) Mean value of all supplied arguments
Switch(n, a, b, …) Returns a for n = 0, b for n = 1, etc.

PID Controllers
PID(x, p, i, d) PID controller
PI(x, p, i) PI controller
PID_G(x, p, i, d) PID speed controller
PI_G(x, p, i) PI speed controller

Predefined Formulas
Available soon
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1) About the current version of TurboLab 2000

This manual supports TurboLab v1.78 and TurboLab 50 v5A

2) Sample software license

TurboLab Software Certification
This is a Site License for TurboLab 2000 and 5.0 Analysis.

Your Site License number is: XXXXXXXXXXXXX

This Site License for TurboLab 2000 Acquisition and TurboLab 5.0 Analysis Software for use on the
microEEP-5 Data Acquisition Computer serial number XXXXXXXX and is issued to:

Name
Company

This Site License is good for use on a single computer only. This software is proprietary and is not to be
distributed or copied. This license is not transferable and is usable to the issued corporation only.
If you have any questions or concerns with this license or software, Please contact CORRSYS-DATRON.
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3) Update Bulletins

a) Bulletin 1001 - How to Manual Install TurboLab 2000 DLL's in the NT Registry

TurboLab did not install all required .dlls in registry. You must be logged on as an administrator for
this operation to be performed.

1-Go to MSDOS prompt window.
2-Go to the program files directory
3-Go to the TLONLINE subdirectory in the program files directory
4-Type regsvr32 (plus the name of the DLL that did not load)**

**The list of the DLLs that did not load can be found by opening the TurboLab 2000 install.log file
that is in the tlonline directory.

Example text entry:
C:\program files\tlonline> prompt
regsvr32 formula.dll
regsvr32 sae.dll
regsvr32 datronlcd.dll
regsvr32 tablefile.dll
regsvr32 cansja.dll

After each entry, you will get a window message that says that the entry has been accepted and reg-
istered in the registry.

Once done simply reboot the computer and you will find all of the missing signal channels added to
the signal new selection window.____

An Example of the TurboLab 2000 install.log is shown on the next pages with the Could not Self-
Register file lines.  This is what you will look for to conform what DLL files were not installed in the
Registry duing the TurboLab 2000 instalation.
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A example TurboLab 2000 install.log is shown below. Look for the lines that
start with Could not Self-Register:.

***  Installation Started 05/07/01 16:01  ***
Title: TurboLab Online Installation
Source: D:\TL2000 Windows Software\tl2000.EXE
Made Dir: C:\Program Files\TlOnline
File Copy: C:\Program Files\TlOnline\UNWISE.EXE
RegDB Key: Software\Microsoft\Windows\CurrentVersion\Uninstall\TurboLab Online
RegDB Val: TurboLab Online
RegDB Name: DisplayName
RegDB Root: 2
RegDB Key: Software\Microsoft\Windows\CurrentVersion\Uninstall\TurboLab Online
RegDB Val: C:\PROGRA~1\TLONLINE\UNWISE.EXE C:\PROGRA~1\TLONLINE\INSTALL.LOG
RegDB Name: UninstallString
RegDB Root: 2
File Copy: C:\Program Files\TlOnline\TableFile.dll
File Copy: C:\Program Files\TlOnline\formulas.hpi
File Copy: C:\Program Files\TlOnline\Cancard.dll
File Copy: C:\Program Files\TlOnline\CANSja.dll
File Copy: C:\Program Files\TlOnline\Sae.dll
File Copy: C:\Program Files\TlOnline\DatronLCD.dll
File Copy: C:\Program Files\TlOnline\Formula.dll
File Copy: C:\WINNT\System32\Atl.dll
File Copy: C:\Program Files\TlOnline\turbolabsig.dll
File Copy: C:\Program Files\TlOnline\Aep5.dll
File Copy: C:\Program Files\TlOnline\tlunits.ulb
File Copy: C:\Program Files\TlOnline\CreateDlgSig.dll
File Copy: C:\Program Files\TlOnline\TurboLab 2000.exe
File Copy: C:\WINNT\System32\MFC42D.DLL
File Copy: C:\WINNT\System32\MSVCRTD.dll
File Copy: C:\WINNT\System32\MFCO42D.DLL
Version: Following file not copied.
File Overwrite: C:\WINNT\System32\oledlg.dll

File Overwrite: C:\WINNT\System32\MSVCRT.dll
File Copy: C:\WINNT\System32\SHLWAPI.dll
File Copy: C:\Program Files\TlOnline\turbolab.dll
File Copy: C:\Program Files\TlOnline\tlparser.dll
File Copy: C:\WINNT\System32\msidle.dll
File Copy: C:\Program Files\TlOnline\Display.dll
File Copy: C:\Program Files\TlOnline\helper.dll
Made Dir: C:\WINNT\Profiles\All Users\Start Menu\Programs\TurboLab Online
Shell Link: C:\WINNT\Profiles\All Users\Start Menu\Programs\TurboLab Online\TurboLab 2000.lnk
Shell Link: C:\WINNT\Profiles\All Users\Start Menu\Programs\TurboLab Online\Uninstall.lnk
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: 1
RegDB Name: Type
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: 2
RegDB Name: Start
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: 1
RegDB Name: ErrorControl
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: \??\C:\PROGRA~1\TLONLINE\aep5.sys
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RegDB Name: ImagePath
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: AEP5
RegDB Name: DisplayName
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5
RegDB Val: 
RegDB Name: Group
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 7
RegDB Name: Irq
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 0
RegDB Name: Dma
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 528
RegDB Name: Base1
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 756
RegDB Name: BaseC
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 544
RegDB Name: Base2
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 0
RegDB Name: Base3
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 1
RegDB Name: Adr1
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 1
RegDB Name: Adr2
RegDB Root: 2
RegDB Key: SYSTEM\CurrentControlSet\Services\AEP5\devices\AEP5\0
RegDB Val: 0
RegDB Name: Adr3
RegDB Root: 2
Could not Self-Register: C:\PROGRA~1\TLONLINE\TABLEF~1.DLL
Could not Self-Register: C:\PROGRA~1\TLONLINE\CANSJA.DLL
Could not Self-Register: C:\PROGRA~1\TLONLINE\SAE.DLL
Could not Self-Register: C:\PROGRA~1\TLONLINE\DATRON~1.DLL
Could not Self-Register: C:\PROGRA~1\TLONLINE\FORMULA.DLL
Self-Register: C:\WINNT\system32\ATL.DLL
Self-Register: C:\PROGRA~1\TLONLINE\TURBOL~1.DLL
Self-Register: C:\PROGRA~1\TLONLINE\AEP5.DLL
Self-Register: C:\PROGRA~1\TLONLINE\CREATE~1.DLL
Could not Self-Register: C:\WINNT\system32\MFC42D.DLL
Self-Register: C:\WINNT\system32\MFCO42D.DLL
Self-Register: C:\PROGRA~1\TLONLINE\turbolab.dll
Self-Register: C:\PROGRA~1\TLONLINE\tlparser.dll
Could not Self-Register: C:\WINNT\system32\msidle.dll
Self-Register: C:\PROGRA~1\TLONLINE\DISPLAY.DLL
Self-Register: C:\PROGRA~1\TLONLINE\helper.dll
User Rights: Admin
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b) Bulletin 1002 - How to reopen the left window in 
TurboLab 2000

If you lose the left windowpane in TurboLab, please follow the steps below to repoen the window.

1. Make sure you are logged in as an Administrator.  The default Administrator password is 
"admin".  You will need administrator right to correct this problem.

2. Close all open applications.  The next steps will not be able to be compleated if any other
applications are running.

3. Open the Start menu and select Run.

4. Type in "regedit".  This will open the registry editor.  Be carful to only follow the steps here.  
Modifying and deleting parts of the registry can cause your operating system to be dammaged 
and not function.

5. Open the "HKEY_CURRENT-USER" folder by clicking on the + sign.

6. Open the "Software" sub folder.

7. Open the "MDZ" sub folder.

8. Open the "TurboLab" sub folder.

9. Click on the State folder so that it is highlighted.

10. Go to the Edit menu and select Delete.

11. When prompted if you are sure you want to Delete this key,  choose YES.

12. Close the Registry Editor.

13. When you now reopen TurboLab 2000 you will have the left window back.

We are currently working on a fix for this issue and it should be fixed in version 1.79.
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c) Bulletin 1003 - File structure and standard software 
installed on the µEEP-5

1. Partition the SCSI HD of the microEEP-5 into a C:\ partition of 4MB's with a file structure of NTFS.

2. Only install Windows NT. (We are no longer installing DOS or making a dual boot systems structure.)

3. When installing Windows NT. DO NOT INSTALL NETWORK SUPPORT.
(See Technical Bulletin 1004 for details.)

4. Once NT is installed, create an extended partition with the remaining space on the SCSI
hard drive labeled d:\.

5. Create a new folder called Utilities on the d:\ drive.

6. Install latest Microsoft Windows Service pack.

7. Copy the motherboard LAN drivers to the Utilities directory and if necessary unzip the drivers.

8. Install motherboard LAN drivers. (See Technical Bulletin 1004 for details.)

9. Setup Network TCP/IP settings and connect to DATRON1 network.

10. Copy the following list of programs into the Utilities directory for DATRON1.
-Latest version of TurboLab 2000,
-Latest TurboLab 2000 support files,
-Latest version of TurboLab 5.0,
-Latest TurboLab 5.0 support files,
-Latest version of the TurboLab Users Manual with install appendixes,
-Iomega driver install and support programs,
-CeCalWin
-Lap Link Gold Install program,
-Windows Commander,
-WinZip and Acrobat Reader
-Motherboard VGA drivers,
-Motherboard SCSI, and
-Motherboard LAN Drivers.

11. Install all Programs listed above.
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d) Bulletin 1004 - Steps to install the LAN drivers on a µEEP-5

These setups will take you throught the installing of the LAN drivers for the Eagleray motherboard
used in the µEEP-5. You should have previously installed Windows NT WITHOUT network support.

1. Install the latest Service Pack for Windows NT.
(The Eagleray motherboard LAN drivers require Service Pack 4 or highter.)

2. Copy the Intel® 82559 Fast Ethernet LAN on Motherboard driver to the Utilities directory.

3. Unzip the Intel® 82559 Fast Ethernet LAN on Motherboard Driver and install the driver in
the default c:\Intel directory when prompted.

4. Right click on the Network Neiborhood icon on your desktop and select Proprities.

5. You will be prompted as to weather you want to install or setup the network.  Click OK.
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e) Bulletin 1006 - Description of Tell-Tale Lights

The uEEP-5 requires:
AC voltage of 50Hz of 115V…230V at Max. 5A or
DC voltage of 10V…32V at Max. 25A.

When you supply AC or DC voltage to the uEEP-5 the Green "POWER GOOD" tell tail light will be
illuminated as shown below:

When the uEEP-5 has lost or is not provided AC or DC voltage and is running off of the internal bat-
tery backup supply the Red "ACCU ACTIV" tell tail light will additionally be illuminated, as shown
below:

When the uEEP-5 has exhausted or empty the internal battery backup supply, the uEEP-5 will loose
power and turn off automatically and the RED "ACCU EMPT" tell tail light will additionally be illumi-
nated, as shown below:
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f) Bulletin 1007 - TurboLab .tlb file will not open

When you open a TurboLab 2000 .tlb file and you get the error message 80040154. This means that
the .tlb was created with or has signal channels that require an installed .dll file that is not installed in
the version of TurboLab that you are trying to open the file in.  

Ex.  A .tlb file was created and has j1850 signal channels but the version of TurboLab you are trying
to open the file in was not installed with the J1850 support .dll file. 

Ex.  If a file was created and has a LCD display but you try to open this .tlb in a version of TurboLab
that does not have the LCD Display .dll driver installed you will get the same error message.

To open this .tlb file, you will have to do one of two things:

1) Open the .tlb in a version of TurboLab that has the required .dll installed and deletes the channels
that are creating the conflict,

OR

2) Reinstall TurboLab 2000 over your current version with the required .dll selected.
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g) Bulletin 1008 - TurboLab .tlb file will not open

When you open a TurboLab 2000 .tlb file and you get the error message 80030005.  This means
that the .tlb has a Read Only attribute.  

Ex.  A .tlb file was written to a CD-Rom disk for transportation or archiving purposes and is now try-
ing to be opened. 

To open this .tlb file, you will have to the following:

1. Open Windows Explorer from the Start Menu/Program Files/Windows Explorer.

2. Locate the problem .tlb file and right click on the file.  This will bring up a pop up quick command menu.

3. Select <Properties> from this pop up quick menu.

4. At the bottom of this Properties Window you will see that both the Archive and Read Only Boxes
are checked.

5. Un-check the box next to Read only.

6. Click on the <OK> button.

7. You will now be able to open the .tlb file in TurboLab 200
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h) Bulletin 1009 - Changing TurboLab 5.0 display axis
and file name display options

If you find that TurboLab 5.0 Analysis is displaying all of the axis on one side, then a Script file was
probably run that did not complete it fill function and has not reset the axis options. To correct this
simply:

1. Select File/Settings/Options.

2. Select the Axes Tab, and reset the options to the below values.
Check - Automatic Axes Assignment,
Under Position - Select - left and right
Check - One axis per unit
Check - One axis per scale range
Check - Include signal names ($SIGNAL)
Check - show time only

To see the file name and section of each signal in a layout you will have to add a line in TurboLab
Variables.  To do this, follow the following steps:
1. Press <F4>.
2. Select <Variables>.
3. Using the scroll on the right, go down to the first available line that is open.
4. Add <FULLNAME> under the Name line in capital letters, and add a description of something 

like <Displays fill file and section name for each signal channel> under Value and press <Enter>.
5. Click on the <OK> button.
6. Now simply change any value or scale in the layout and all of the file and section names will be 

added for every signal displayed in that layout.
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i) Bulletin 1010 - Installing Softing CAN Card support
for TurboLab

1. Install the CAN card using the driver installation routine.

2. You will have to execute the registry file in the registry subdirectory.

3. Then you have to check that the CAN card is running with the cantest.exe program in the folder 
Cancard v4.xx\win32.
If you get error messages you have to de-install the driver again and reinstall it while selecting a 
different address. This card needs reserved system memory and I have not found any way to 
check which system memory is available and which not. I had a lot of conversation with softing 
and they told me to try the different ones until one of them works.

4. If you are successful with the cantest.exe program you have to do on more thing to make 
TurboLab work with the CAN card. Except installing the softing cancard support with the TL
installation. You have to copy the file: canac104.dll from Cancard v4.xx\win32 directory into the 
TurboLab directory.

5. Rename the cancard.dll into CAN card.old and the canac104.dll into cancard.dll. This is the
driver turbolab has to work with for the softing CAN card.


